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Critérios de Avaliagao

1. Avaliagdes:
B1 - peso 4- 12 bimestre:
* 10 pontos (avalia¢do prevista para 28/03/2017).

B2 - peso 6 — 22 bimestre:

* 3 pontos (laboratérios)

* 7 pontos (Projetos com apresentacées em 06/06/2017 e
13/06/2017).

SUB - 1 projeto diferenciado (Substitui a menor nota):
* 10 pontos (Apresentacdo prevista para 20/06/2017).

***Datas de acordo com calendario académico!!!
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PLD D2-115 da Altera

O que é um PLD?

E um dispositivo légico programavel (Programmable logic device - PLD) utilizado
para construir circuitos digitais.

Ao contrario de uma porta légica, que tem uma fungdo fixa, um PLD tem uma fungdo

indefinida quanto a sua fabricagdo. Antes de se utilizar um PLD num circuito, este
deve ser programado (via linguagem ou via esquematico).
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PLD D2-115 da Altera

Como o PLD guarda a configuragdo?

Um PLD é uma combinacdo de dispositivos ldgicos e de memdéria. A memoria é
usada para guardar o padrdo que é dado ao chip durante a programagao. Muitos dos
métodos para armazenar dados no circuito integrado foram adaptados para serem
usados em PLDs. Isto inclui:

SRAM

Células EPROM, EEPROM

Memoria Flash

PLDs baseadas em SRAM tem que ser programadas cada vez que a energia é ligada
isto normalmente é feito por outra parte do circuito. Uma célula EPROM é um
transistor MOS (semicondutor de 6xido metdlico) que pode ser comutada por uma
carga eléctrica permanente aplicada no seu eletrodo 'gate'. Uma memoria FLASH é
ndo-volatil, retendo a informagdo mesmo que a energia elétrica seja desligada.
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¢ Questio: Como fransformar o projeto de um sistema digital
(normalmente representado por um desenho contendo um conjunto de
simbolos légicos interligados) em um circuito fisico real, implementado
com Circuitos Integrados (CI’s)?
Utilizaremos como exemplo o circuito logico de alerta de abertura do
cinto de seguranca, representado na figura seguinte.
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PLD (Programmable Logical Devices) caracterizam-se por permitir ao projetista
configurar as células logicas do CI de modo adequado a atender ao projeto, sem a
necessidade de fabricagdo de componentes especiais.

Tipos de PLD:

* SPLD (Simiple Programmable Logic Devices): circuitos com centenas de portas
logicas basicas (AND e OR) e eventualmente registradores, que podem ser
interconectadas pelo projetista através de ferramentas de configuracio de
hardware:

* CPLD (Complex Programmable Logic Devices): circuitos com centenas de
elementos logicos (cada um deles similar a um SPLD), que podem ser
configurados individualmente e interconectados pelo projetista através de
ferramentas de configuragao de hardware;

* FPGA (Field Programmable Gate Arrays): circuitos com centenas de blocos
logicos programaveis individualmente, atraveés de blocos de memoria (tabelas de
consulta), que podem ser interligados através de uma matriz de chaveamento,
também programavel pelo projetista através de ferramentas de configuracio de

hardware. ¢
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FPGA (Field Programmable Gate Arrays): circuitos com centenas de blocos
logicos programaveis individualmente, que podem ser interligados através de
uma matriz de chaveamento.
S =0 =] =] =]
L= eEaE : 5 £
Exemplo de o & Sioce Q1 oo | | l =
arquitetura de LT I i Pl o
um FPGA — 2 ' . ?_ ' '
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[ ] 2_ clk : clk clic
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L ()
] Bloco Bloco Bloco
o l6gico ; l6gico I6gico
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iy iy 7 UL
O Interconexfio programsvel NOTA: As entradas de clock
== Segmento de conaxao podem tar caminhos
————— Caminho para interconexio Fonte: R. Tocci atpades. :‘:‘ g'f:mﬂézﬁxéﬂ
¢
* P4g. 486 TOCCI, 112 edicdo 9 kroton
Aula7
Resumo da organizacio logica de um FPGA:
Bloco de Memoéria (LUT) + FF + MUX - CLB (Blocos Légicos Configuraveis)
Sclect
Switch Matrix
(Matriz de
Interconexdaes)
I1I0B
(Blocos de
Entrada e Saida)
[
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Correcao de Erros
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O Projeto
Sistema simples de alarme de automdvel para detectar, quando a Chave de
Ignicdo esta ligada, se o Cinto de Seguranga néo esté afivelado ou uma das
Portas est4 aberta.
s T e —
/< Luz de Alerta para _2 ~——
:\/ - Porta Aberta P
{ = —
b ,V_,,/ = __,/'/ ‘\-"’“\» o
R /"‘( Luz de Alerta para __%
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Passo a passo

Iniciar um Novo Projeto

Para comecar a trabalhar em um projeto novo, primeiro temos que definir um
escopo para este projeto. O “software” Quartus |l facilita esta tarefa

fornecendo suporte na forma de um Assistente (“Wizard”). A criagdo de
um Novo Projeto segue as etapas detalhadas a seguir.

a) Selecionar File > New Project Wizard para iniciar o Assistente de Novo
Projeto o qual direciona a criagdo e configurages preliminares de um Novo
Projeto.

b) Na janela “New Project Wizard: Introduction”, clicar em Next.
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Janela “New Project Wizard: Add Files”. O Assistente de Novo Projeto
permite incluir arquivos pré-existentes (se houver) no Projeto.

Mow Projoct Wazand: Acd Filas [paga 2 af S]- ==
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Eie e | =] 44
Tl rame [Tipe [Lirmry [Cmsign entryday. [ HOL wersar Al
_w |

= Back. I Nexd = Firsh

he pth names of 2y fvaiizs Liger Lineaties
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Na janela “New Project Wizard: Family & Device Settings”:

f.1) Especificar o tipo de dispositivo no qual o circuito projetado sera
implementado.

No campo “Device Family — Family:”, escolher Ciclone IVE como Familia do
dispositivo de destino.

f.2) Pode-se deixar o “software” Quartus Il selecionar um dispositivo especifico
na familia, ou podemos escolher o dispositivo explicitamente. Utilizaremos esta
Gltima abordagem

No campo “Target device” escolher a opgao “Specific device selected in
‘Available devices’list”.

f.3) No campo “Available devices” aparece uma lista de dispositivos
disponiveis, escolher o dispositivo denominado EP2C70F896C6 que é um
PLD utilizado na Placa Didatica de Desenvolvimen

¢
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&4 New Project Wizard - =z
Family & Device Settings [page 3 of 5]
Select the family and device you want to target for compiation.
You can instal additional device support with the Install Devices command on the Tooks menu.
Ta determine the version of the Quartus IT software in which yaur target device is supparted, refer to the Device Suport List webpage.
Device family Show in ‘Avalable devices' list
Family: [Cydone IVE - Package: [any B
Devices: [Al Pin count: [any -
B — Core Speed grade: [Any -]
") Auto device selected by the Fitter faiEs
@ Specific device selected in ‘Available devices' st Show advanced devices
Other: nfa
Available devices:
Name Core Voltage LEs User1/0s Memory Bits Embedded multiplier 9-bit elements. PLL -
EP4CE75F2317 LV 75408 293 2810880 400 4
EP4CE75F2318L Lov 75408 293 2810880 400 4
EP4CE75F29C6 L2V 75408 427 2810880 400 4
EPACETSF29CT 2810880 0 [ |
EP4CE75F29C8 LV 75408 427 2810880 400 4
EP4CE75F29C8L Lov 75408 427 2810880 400 4
EP4CE75F29CSL Lov 75408 427 2810880 400 4 L
EP4CE75F2917 LV 75408 427 2810880 400 4
EP4CE75F2918L 1oV 75408 427 2810880 400 4 e
<] i ] v
<Back | [ Mext> [ Finsh ][ cencel ][ Heb ] ¢

!
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Resumo das Configuracdes escolhidas:

T New Project Wazard ———m . . 9 [,

Summary [page 5 of 5]

When you clik Firish, the project wil be created with the following settings:

Project directary: Cilalteral14.0
Project name: aulal
Topdevel design entity: aulal
Number of fies added: 0
Number of user libraries added: 0
Device assignments:
Famiy name: Cydone v E
Device: EP4CE7SF29C7
EDA toals:
Design entryjsynthesis: <None> (<None>)
Smulation Modelsim-Altera (VrDL)
Timing analysis: 0

Operating conditions:

VCCINT voltage: 12v
Juncton temperature range: o8s°C
[ eBack ][ wet> |[Fmsh | [ concal ][ mep ]
I¢
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€ Quartus I164-5it - Cy/altera/140/aulal ~aulal W W

File Edit View Project Assignments Processing Tools Window Help 5

DEH@ % D@ 9 o Y S F O
[Project Navigator 18 x
Entity
/A Cydone IV E: EP4CE7SF29C7
> aulal &

QUARTUS? Il SOFTWARE v13.1:

GET THE COMPETITIVE EDGE WITH THE
- -ASTES T4€8;

A vierarchy [ ElFles [ ¥ e 4|
[Tasks pe x|
Flow: [Corwianon '] [Cuslnmtu]

Task
4 Compile Design
> B Analysis & Synthesis
b B Fitter (Place &Route)
S z
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Para descrever o circuito no formato de Captura de Esquematico deve-se uwsar o Editor
Grafico do Quartus II. conforme as etapas detalhadas a seguir.

a)  Selecionar File > New para obter a janela da Figwa 14. Escolher “Block Diagram /
Schematic File” e clicar em OK. Isso abre a janela do Editor Grafico (Figural5).

et Qv || Pojet
© SORC Bk Syslan
- Desin Fikes

L AHOLFie

St Machiee Fle
Syskanverbg HOL Fin
Tel Zerpt File

“erlog HIL i

& Merren Fie:

& Werbeaicr Deboggrg Fle:

SigralTap | Lacic snadyocs Fla
“Feclon Wmeetcan Fin

= Cever Filas
SHOL ek e
Black Symhol File
Chain Dezerivion File
Syropee Daegn Corsdraie: Filk
TestFis
Lo ] e |
=}
19
€4 Quartus I 64-8it - Ciahera/I40/aulal - sl | ——— = o e ]
Fle Edt Vew Proect Amgwents Processng Toos Widaw hep T . ")
DS dd 428 90 [ HY ,¥FL 0 PP OO AR P L 0 ®
[Praject Navigatar vex|[ & Block1bdf g 1P Catalog 8x
L F@EaVADE-O17ANNSOOND 9 X =
Ay Cydore IVE: EPACETF2CT . o T - -
e : HE P pa—
# Project Directory
+ Basc Fuctiors
o5
» Interface Protocols
» Memory Interfaces and Contralers
Processors and Penpherals
# Library
Sasc Functiors
o
» Interface Protocols
Ay vierarchy | ] Fes | o De 4| b + Memory Interfaces snd Contralers
[Tass LERS @ search for Parmer
Fow: Compotn ] [customae.. ]

Task:

4 b compie Desgn
B ansysss & Synihess
# Fiter (lace & Route)
- dssembier (Generaie prog|| |
1 TmeGQuest Timing Analyss |
DA Nttt ier :

@ Program Devies (Cpen Progrer

ImEEE® T -

e — \

H

20
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O Editor Gréfico oferece uma série de bibliotecas que incluem elementos
de circuito que podem ser importados para um esquematico. D& um duplo
clique no espagco em branco na janela do Editor Grafico, ou clique no
icone na barra de ferramentas que se parece com uma porta AND .

1r

Va4 em “libraries”, em seguida, expandir a biblioteca “primitives”,
seguido de expansédo da biblioteca “logic” que compreende as portas
légicas. Selecione “and2”, que é uma Porta E de duas entradas, e clique
em OK. Agora, o simbolo da Porta E aparecera na janela do Editor
Gréfico. Usando o mouse, mova o simbolo para um local conveniente e
clique para coloca-lo Ia. Importar a segunda

i¢
21 kroton
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£ Quartus T1 64-8it - C/altera/14.0/aulal - aulal T - 5 =
> ghica ®
T IR T IR Y S [ A e BT AR JF IR
Project Nevigatar iax| = BlockLbdf [x] IP Catalog e x
Enoey B eRTABS-OI1INNSOON Y FAD w8/ dS & ad 3 a X =
Ay Cydone IV E: EPACEPFISCT 7.
> adal 25 Irataled 17
( % Syt
e R R R N
t + © cun/ia oiguarnshbanesl «
© megafunctions L S hace Protucols
) SEREEEISEE & others
iy rersrchy | EIFe | o d[p]p = ¥ Ierfaces and Conrolers
Tosks isx © bufier S S S R S parter 1P
X - Y SEREEEISEY. « Blge
ow: [Compitn ] oo ]+ D2
Task t . o andz
- SESEISES. O s
+ # Comple Desgn & e
B drolyss & Synhess .
B Fiter Bloce & Route) f—
B assenbier Generate peeg | =
B TmeQuest Trng Aralyss [ 11111
> EDA Netist viriter ¥/ Repeat-nsert mode:
W Prooram Device (penProgran [ 1111111 ] nsert symbol as blodk.
|« vl I
o Cancal
Mea@E v |
#ltype ID Message
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Lo ce At b IR |
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Figura 20 Importar os simbolos das Portas Logicas e organiza-los na janela do Editor
Grafico.

¢
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Pin Proparties (S

General ] Fornat |

To create nuitiple pins, enter a name in AHDL buz notation (for example,
“name[3.0]"] ar enter a camma-s=parated list of names.

Pivnamefs): [Chave_lgnicas

Dofauk valus: [VCE -

Cancelar

Vamos acrescentar trés saidas intermediarias no circuito!!!

24
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Compilar o Circuito Projetado

O arquivo do diagrama esquematico descrito — Luzes_de_Alerta.bdf, sera
processado por vérias ferramentas do Quartus Il que irdo analisar o arquivo,
sintetizar o circuito, e gerar uma implementag&o deste circuito para o chip de
destino. Estas ferramentas sdo controladas pelo programa aplicativo chamado
Compilador.

Para executar o Compilador selecionar Processing > Start Compilation, ou
clicar no icone da barra de ferramentas horizontal.

-

A medida que a compilacéo passa pelos varios estagios, seu progresso
€ relatado em uma janela no lado esquerdo da tela do Quartus Il (janela
“Tasks”). O sucesso (ou insucesso) do processo de compilagdo é

indicado em uma caixa de diéalogo,

2 k[otqnlt
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aul
Fle Edt View Project Asgoments frocessng Tools Window Hep %)

DEFE@ 4 2@ 9 o | Y EGe D
Project Naigater LEEIR™Y ™ SR .
—— AREAVADE-
Ay Cycone IV E: EPACE11F25C7 e —
Baterd ||

Simulagao

Aparece status na
janela Tasks!!

0 g
Aytiearchy | SlFes | Foe [N

B

Task

4 P Compic Desion
b Analysis & Synthesis
b B Fitter (Place &Route)

b B assembler (Generate prog
» B TimeQuest Timing Ansiys:
b B EDA Netist Writar

W program Device (Cpen Prograd | /-

i

ID  Message
(170183 Ficcer
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Atribuig&o de Pinos do PLD w

Assignments > Pin Planner

P ———————— P
@ Goge  W8x| Top View - Wre Bend
Named: * - Cycione IV E - EPACE1ISF BCT
x
(] )
" Unbonded pad
Reservedpn
FIE™ < Other configuraton
E DEV_OE
-] | 5 oeas
? Tosks. 18 x| ® DIFF_n
4 2 EartyPrPiernng - 2 yj
# (3 ey P Parving... [E D om
- » Run 10 Assigrment Anslysis [1] axn
® T Export Pin Assgrments... axp
% - - Qther 211 4
| Noed: = - e ]
o8 Hoce ame Orecton
& Sensor_onto output
TN Output
U ' Chave _ignicss Tnput
4 Led_Cinto Output.
54 Led Porta uput
5 Senaor ¢ tput
2|1, Sensor_porta tnput
] Bl i

28 krotonle
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Atribuicéo de Pinos do PLD

Assignments > Pin Planner

ALRERAW
Y23 Cyci 91‘, AB28
AC28

!!E!----H!!!

SW17 SW16 SW15 SWi14 SW3 sw2 Sw1 SWo Logic"0"

Figure 4-8 Connections between the slide switches and Cyclone IV E FPGA

¢
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Table 4-1 Pin Assignments for Slide Switches

Signal Name FPGA Pin No. Description 1/0 Standard

SW[0] PIN_AB28 Slide Switch[0] Depending on JP7

SW[1] PIN_AC28 Slide Switch[1] Depending on JP7

SW[2] PIN_AC27 Slide Switch[2] Depending on JP7

SW[3] PIN_AD27 Slide Switch[3] Depending on JP7

SW[4] PIN_AB27 Slide Switch[4] Depending on JP7

SW[5] PIN_AC26 Slide Switch[5] Depending on JP7

SW[6] PIN_AD26 Slide Switch[6] Depending on JP7

SW[7] PIN_AB26 Slide Switch[7] Depending on JP7

SW[8] PIN_AC25 Slide Switch[8] Depending on JP7

SW[9] PIN_AB25 Slide Switch[9] Depending on JP7

SW[10] PIN_AC24 Slide Switch[10] Depending on JP7

SW[11] PIN_AB24 Slide Switch[11] Depending on JP7

SW[12] PIN_AB23 Slide Switch[12] Depending on JP7

SW[13] PIN_AA24 Slide Switch[13] Depending on JP7

SW[14] PIN_AA23 Slide Switch[14] Depending on JP7

SW[15] PIN_AA22 Slide Switch[15] Depending on JP7

SW[16] PIN_Y24 Slide Switch[16] Depending on JP7

SW[17] PIN_Y23 Slide Switch[17] Depending on JP7

30 kroton'e
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Table 4-3 Pin Assignments for LEDs

Signal Name FPGA Pin No. Description /O Standard
LEDR[0] PIN_G19 LED Red[0] 2.5V
LEDR[1] PIN_F19 LED Red[1] 2.5V
LEDR[2] PIN_E19 LED Red[2] 2.5V
LEDR[3] PIN_F21 LED Red[3] 2.5V
LEDR[4] PIN_F18 LED Red[4] 2.5V
LEDR[5] PIN_E18 LED Red[5] 2.5V
LEDR[6] PIN_J19 LED Red[6] 2.5V
LEDR[7] PIN_H19 LED Red[7] 2.5V
LEDR[8] PIN_J17 LED Red[8] 2.5V
LEDR[9] PIN_G17 LED Red[9] 2.5V
LEDR[10] PIN_J15 LED Red[10] 2.5V
LEDR[11] PIN_H16 LED Red[11] 2.5V
LEDR[12] PIN_J16 LED Red[12] 2.5V
LEDR[13] PIN_H17 LED Red[13] 2.5V
s kooton®
Aula 7
ANTERAN
LEDR[14] PIN_F15 LED Red[14] 2.5V
LEDR[15] PIN_G15 LED Red[15] 2.5V
LEDR[16] PIN_G16 LED Red[16] 2.5V
LEDR[17] PIN_H15 LED Red[17] 2.5V
LEDGI[0] PIN_E21 LED Green[0] 2.5V
LEDG[1] PIN_E22 LED Green[1] 2.5V
LEDG[2] PIN_E25 LED Green[2] 2.5V
LEDGI[3] PIN_E24 LED Green[3] 2.5V
LEDG[4] PIN_H21 LED Green[4] 2.5V
LEDGI5] PIN_G20 LED Green[5] 2.5V
LEDGI6] PIN_G22 LED Green[6] 2.5V
LEDGI[7] PIN_G21 LED Green[7] 2.5V
LEDG[8] PIN_F17 LED Green[8] 2.5V
32 kroton'e
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& Quartus I 64-Bit - C:/Users/Cristiano/Desktop/Teste/aulal - aulal
File Edit View Project Assignments Processing Tools Window Help 5

DEEHSP %@ 9 o[ = S EROQ PN DR P A e
Project Navigator e x| Compilation Report - aula ol aulalbdf o |
Entity FRagAacz-O11ANNYOO0ON D S it H S| %R
Ay Cydone IV E: EP4CE115F29C7
B aua1 Ll
i Pincs oe Erirada d Greui: Saidas brmediaras 1T ios de SaidadoCin
DUIUTND fCevelignioee [y e
[PIN_AAZZ ] QUIBUT P igensor_Cinto CoLEEEDT T Alame
T SEesei i g CPN_ATS | PP
T o o S |=|_
T SensorFois TS g [P ]
I o S Aot |
: ‘2 b
A Hierarchy | Files | JDE"D'- -9 —_— Led_Ginto .
: ] e -
[Tasks ngx|| I st :
ORZ i
Flow: \Comnilahon v| ‘Custnm\zﬁ.” | : ) =
13
Task ins}
# Compile Design
[N - Asynth Chave. Ignicaa ANDE e Fas
alyis 8 Synthess g ———
b B Fitter (Place & Route) -9
- X | )
b B Assembler (Generate prog E
b B TimeQuest Timing Analysi e
b B EDA Netiist Writer
U Program Device (Open Prograr
« n K [
= @ P <<Search>> ~
Bl Type ID Message
o L) 144001 Generated suppressed messages file C:/Users/Cristianc/Desktop/Teste/output_files/aulal.fit.smsg
i
| [ ——
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Atribuicdo de Pinos do PLD

Assignments > Assignment Editor

T AR e ———_ -

Processing  Tools Window Help 5

[auat Y EFS D e DU MRS B A0S
- | @ compiation Report -auia1 [ | aulaL.bdf O | % AssomentEdtr @ ‘
<<new>> v [V]Filter on node names: * - Catego(y:[Nl -
@ty From To Assignment Name Value Enabled Entity Comment Tag

', Sensor_Porta  Location PIN_Y23 ‘Yes
I, Sensor_Cinto  Location PIN_Y24 Yes
I"_ Chave..nicas  Location PIN_AAZ2 Yes
24 fsensor_Cinto  Location PIN_H15 Yes
4% Led_Porta Location PIN_G15 Yes
?% Led_Cinto Location PIN_F15 ‘Yes
o4 Alarme Location PIN_H17 Yes
<<new>> <<new>> <<news>>

AN SN NN

¢

w
S
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Programacé&o do PLD

Va em Tools > Programmer > Hardware Setup > USB- Blaster [USB-0]
e add o arquivo. sof
D Programmer - CaUsen/CrmianoiDeHiop Tete/alat sl s ] D)

Fie Edt View Processng Toos Window Hep %) Search altera.com ]

5 Hardnare Setup... | No Hardware Mede: [ITAG ~ Progress:
Enable real-time ISP to allow background programming {for MAX 11 and MAX V' devices)
TR Fike Device Checksum  Usercode  Program/  Verfy  Bank-  Examine
il start Configure Check

e
[ Kockte |
|l save File
[ me
[ Peoom |

¢

|- kn:)l:onI

paZo por educar

Aula 7

Programacé&o do PLD

Apos isso clique em start e acompanhe o progresso

4 Programmer - C/Users/Cristi ste/aulal - aulal - [Chain3.cef] ‘m E@g_
Fle Edt View Processing Tooks Window Hep % Search altera,com @

2 Hardnare Setp...] No Hardware Mode: [TTAG v) ragress: |

Enable real-time ISP to allow background programming (for MAX IT and MAX V devices)

S T— Fie Device Checksum  Useresde  Program/  Verfy  Bank-  Examne
Configure Chedc
[ dbswp |
3 Auto Detect
X Delete
14 change Fie. o -
el Save File
thu
e

¢

|' kn:)l:onI
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< Aula 7

Através das chaves e LEDs, testar o circuito projetado e programado no PLD,
completando a Tabela Verdade abaixo:

Variaveis de Entrada Varidveis de Saida

SW17 SW16 SW15 LEDR17 LEDR15 LEDR14 LEDR13
Chave_lgnicio Sensor_Porta Sensor_Cinto /Sensor_Cinto LED_Porta LED_Cinto Alarme

0 0 0

0 0 1

0 1 0

0 1 1

1 0 0

1 0 1

1 1 0

1 1 1

7 kroton*
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